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CHAPTER 1

Intfroduction

Welcome to the Flare Getting Started Tutorial, which will show you how to use MadCap
Flare's basic features. During this tutorial, you will create a project about San Diego, add ele-
ments to it, and then build PDF and HTMLS5 outputs from it.

This chapter discusses the following:

Using the Getting Started Tutorial ................ ... ... . ... 6
Using the San Diego Project Template ... . ... ... ... 6
For More Information ... . 7
Readyto Begin? .. ... 7
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Using the Getting Started Tutorial

The Getting Started Tutorial is designed in a self-guided format. You can go through the tutorial at your own
pace and complete as much or as little of the tutorial as you want.

The Getting Started Tutorial covers the following:

1. Starting Projects How to build a new project from a template. See "Starting Projects" on page 9.

2. Adding Elements to Projects How to add content to your projects, such as topics, images,
cross-references, and snippets. See "Adding Elements to a Project” on page 17.

3. Making It Look Good How to use styles to make your project look the way you want it to. See
"Making It Look Good" on page 47.

4. Developing Targets How to prepare your output using conditions, PDF and HTMLS5 outputs,
skins, and tables of contents. See "Developing Targets" on page 55.

5. Building Output How to build the final printed and web outputs for your project. See "Building Out-
put" on page 81.

Using the San Diego Project Template

While you follow the steps in the Getting Started Tutorial, you will also use Flare's San Diego template to
create a project about San Diego. This template was designed to be used alongside the tutorial and will
give you hands-on experience in Flare. As such, some settings and content are not enabled when you first
open the template. By following the steps in the self-paced tutorial, you can add the rest of the content to
the template, and even use the template for other projects.

You might want to take some time to familiarize yourself with the topics that have already been created for
the San Diego template. You can find these in the Content Explorer on the left side of the interface. If you
want, you can also select the Project ribbon at the top of the interface and click the Build Primary button
to generate output from the template right away. This gives you an idea of how one type of output might
look.



For More Information

There is much more to learn outside of the features covered in this tutorial. Additionally, while this tutorial
covers the recommended or most efficient way to perform a task, there are usually several other methods
that you can use. Take some time to explore Flare on your own and find the technique that is most com-
fortable for you. Refer to the Flare online Help for more information about any of the features covered in this
tutorial.

For new users, we also recommend the following:

» Getting Started Guide This short PDF guide explains how Flare works and introduces you to some
of its key features and concepts. It then outlines the five basic steps for developing a project and pro-
ducing output. To download the PDF, see the online Help.

» Getting Started Video This brief movie shows you how to start a new Flare project and gives you
insight into what you should do once that is accomplished. You can view this movie from the mad-
capsoftware.com website.

Ready to Begin?

To get started using the San Diego template, see "Starting Projects"” on page 9.

CHAPTER 1| Getting Started Tutorial 7






CHAPTER 2

Starting Projects

Begin by creating a new Flare project and taking a tour of the workspace.

This chapter discusses the following:

Creating a ProjectfromaTemplate ... . ... 10
Flare's User Interface
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Creating a Project from a Template

A template is a Flare project that already contains a few basic topics, styles, and outputs to help you start
writing quickly. After your new project is loaded, you can make any changes as necessary.

CREATE A NEW PROJECT FROM A TEMPLATE

1. When you first open Flare, you will see the Start Page in the middle of the interface. On the Start
Page, click New Project. The Start New Project Wizard opens. This is where you can specify basic
settings for your project.

Getting Started

* Open
Oipen File

fli=] New Project
Starts the Mew Project 'Wizard

2. Inthe Project name field, name your project San Diego.

3. (Optional) In the Project folder field, you can enter a location where you want to save your project.
By default, projects are saved in your Documents>My Projects folder.

Project

Project name: 5an Diego -

Project folder: C:Wsersusername\Documents My Projects - E
Language

Languages with installed spell check dictionaries are displayed in bold.

Language: English (United States) -

4. Click Next.

The next screen in the wizard allows you to select the kind of project you want to create: a template,
a new project based on an existing project, or an imported project. We are going to create a project
using an existing template.
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5. Under Factory Templates, expand the Tutorials folder. Select the San Diego template.

Start New Project

Start 2 new project .
Select a project template. .

Source

(®) MNew from template:

4| Factory Templates
> || Online
> || Online & Print
#

| Print

4 | Tutorials
San Diego
Mg

CHAPTER 2 | Getting Started Tutorial



6. Click Next.

The next screen in the wizard allows you to select the primary target or for your project. A target is a
single instance of an output type, such as a PDF document or an HTML5 online Help system. The
primary target will generate by default when you build output from Flare.

Start New Project Wizard ?

Start a new project ...

Select the primary target...

Available Targets:
' All About San Diego PDF v

Adobe PDF

Short for "Portable Document Format™ PDF is an open file format created by Adobe. PDF files
represent two-dimensional documents in a device-independent and resolution- independent fixed-
layout document farmat.

You can generate POF output from your project directly or you can generate a POF while
simultaneously building FrameMaker or Word output.

You can also set POF options in the Target Editor. These options let you specify the way that
images, document properties, the initial view, and security are handled in the output.

PDF output consists of a file with a .pdf extension that you can print or distribute to users.

7. We only have one target set up right now (we'll add more later), so go ahead and click Finish.

The San Diego project is created and loaded into Flare.

MORE INFORMATION

For more information about using this wizard, see the online Help.
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Flare's User Interface

Before we start opening files and adding content to them, let's take a minute to look at the main areas of the

workspace that you will use during this tutorial.

CONTENT EXPLORER

The Content Explorer appears on the left side of your screen, and is where you can find all of your content-
related files. Topics appear in the main content folder. You can also create subfolders to organize your con-
tent. By default, the Resources folder is used to organize all of your content resources (e.g., images, snip-

pets, multimedia, stylesheets).

The Content Explorer stores
topics, images, snippets, and
other content-related files.

¢ [ ] PrintOnlyTopics
4 | ;| | Hesources
1] Images
| 1] ] MasterPages

= Content Explorer A
N . =8 = @ [& |f E _

QD © B @ LRl —-'*”"r Customsubfolder
L[ | Content holdingtopic files.

[ 1] Pagelayouts
1] Snippets
1] Stylesheets
|1 ] TableStyles
& | | AllAboutsanDiego.htm
& [ | Beerhtm
& [ ] Food.htm

& [ | Homehtm
"L [ ] Read First.pdf

& [ | SanDiegoAttractions.htm
& [ ] SanDiegoCuisine.htm

A v = v

Resource folders
andfiles.

Topic files at the
root folder level.

AllAboutSanDiego Date modified: 8/13/
Chrome HTML Docurnent Siz

JJ Content Explorer

. Project Organizer

CHAPTER 2 | Getting Started Tutorial

Clickthe accordion tabs o
switch between the Content
Explorerand the Project
Organizer.
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PROJECT ORGANIZER

The Project Organizer is also found on the left side of your screen, in the same area as the Content
Explorer. You can click the accordion tab at the bottom to switch between the Content Explorer and Project
Organizer. This is where you can find all of your project-related files, such as targets, tables of contents,
and skins. Each of these types of files appears in its own folder.

The Project Organizer stores targets,
tables of contents, vanables, and

other project-related files.

L2 0

06 EEe

B8 [ | Project
o []]] Advanced
4 || | Conditional Text
% [ | Default
| [ | Destinations
7] Exports
| [ ] Glossaries
[ ] Imports
| [ | Reports
[ 1] Skins
[ ] Targets
= Um | | All About San Diego POF (Primary)
4 [ TOCs
| [ ] Online TOC
= = [ | Print TOC (Master)
4 | [ ] Variables
oz [ ] General

A v F v T T T

] Project  Date modified: 1/28/2016 8:14:14 A...
L" File folder

. Content Explorer

S
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START PAGE

When you first open Flare, you will see the Start Page. Although you won't spend much time on the Start
Page, it is important because you can use it to create a new project, open an existing project, and access
various resources. Also, if you need to stop this tutorial and come back to it later, you can re-open the San
Diego project file from the Start Page's Recent Projects list.

On the Start Page, you can start
new projects, open existing and
recent projects, and access help

resources.
= Start Page w 0w
Getting Started Home Templates Help Resources
¥ Open E ) . ) .
Open File Select any of the following for infermation about getting started with Flare.
s New Project

Starts the Mew Project Wizard

Recent Projects

san Diego.flprj
ChUsers\pstoeckleinyDocumentsi My Proj

/\

The San Diego project

that you just created is

added here, so you can
quickly openit later.

Getting Started Guide Getting Started Video

CHAPTER 2 | Getting Started Tutorial ] 5



XML EDITOR

The XML Editor is located in the middle of the Flare interface. It is the primary editor that you will use in
Flare. It is used for writing, editing, and formatting content files. So once you open a topic, snippet, or mas-

ter page, it will be seen within the XML Editor.

The XML Editor is used for writing,
editing, and formatting content.

Switch between open topic,
snippet, or master page files
by selecting a tab.

/B SanDiegoAttractions.htm = \"f AllAboutSanDiego.htm %

4
=]
4111

h1|

ISan Diego Attractions

There are many places to visitin San Diego. Three ofthese are Balboa Park,
the San Diego Zoo, and Petco Park.

Balboa Park is a 1200 acre park in the middle of downtown San Diego. Inside
the park are gardens, walking paths, and more than a dozen museums. Every
year the park hosts hundreds of events, including concerts, marathons and
races, festivals and parades, and guest speakers.

Words: 144 | Font Scale: |—| 100%

= n

'3 + | %5 Layout (Web) = Medium (default) = Page Layout - % EE -2 @ - T Q ~ | B3

| XML Editor | Text Editor |

B0

MORE INFORMATION

For more information about the Flare interface, see the online Help.
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CHAPTER 3

Adding Elements to a Project

Now that you have created a project, it is time to add content to it. Adding content gives your
project some substance. You can add a variety of different elements to a project.

This chapter discusses the following:

Creating ToPICS ... . 18
Inserting Images ... 23
Inserting Cross-References ... ... ... 25
Inserting Drop-Down Text ... L 30
Using SNippets ... 34
Inserting Tables .. ... . 39
Editing Variables ... .. 44
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Creating Topics

Even though the San Diego project has a few topics already created for you, we will start by adding a brand
new topic.

CREATE A TOPIC

1. Inthe Content Explorer, right-click the Content folder. From the context menu, select New>Topic.
The Add File dialog opens.

@ Note: There are several other methods that you can use to create a new topic. However,

right-clicking in the Content Explorer is the most efficient method because you can select
the folder where you want the new topic to be stored.

2. Inthe Add File dialog, you can select the kind of topic you want to create. In the Source area, make
sure that New from template is selected, then select NewTopic.htm from the list of factory tem-
plates. This will create a new, empty topic.

3. Inthe File Name field, name the topic FamousSanDiegans.

@ Note: You don't have to run words together when typing a file name, like we did here. You

can use spaces if you want.

18



4. Inthe 1st Heading field, enter the heading Famous San Diegans. If you leave this field blank,

the topic will automatically use the file name for the heading. We will leave the rest of the fields

blank for now; the default settings are okay for these fields.

File Type:
[Z) Topic

Source

@ Mew from template:

4| Factory Templates
& NewTopic.htm —=
& TopicForEndnotes.htm
& TopicForGlossary.htm
& TopicForIndex.htm own content.
& TopicForListOfConcepts.htm e
& TopicForListOfElements.htm

& TopicForListOfimages.htm =
& TonicForl istOfTahles.him

m

) Mew from existing:

Select the template
you want to use.

Delete this text and replace it with yvour

Topic
Falder:
(root folder)

Enter the file name.

File Name:

FamousSanDiegans

Enterthe topic

Advanced headlng-
1st Heading:
——
Famous San Ciegans (Always use first topic heading)
Stylesheet: Style:
’Resouroesfst\-'iesheetsﬂﬂainstﬁes - l ’

CHAPTER 3 | Getting Started Tutorial

19



5.

20

Click Add. Your new topic appears in the Content folder. It also opens automatically in the XML
Editor.

After closing the topic, you can re-open it later by double-clicking the file name in the Content
Explorer.

The topic is empty
except for the title and
some placeholder text.

The new topic
appears here.

§ Content Explorer
;ID - @ 1/ B FamousSanDiegans.htm  * N Start Pa
[ Content I3l = | % Layout (Web) » Medium (default) = P Frout - | @) gy =

PrintOnlyTopics
Resources
AllAboutSanDy
Beer.htm

>
s

FamousSanDiegans.htm

Foodhom ° Famous San Diegans

Home.htm
Read First.pdf

SanDiegoAttractions.htm Delete this text and replace it with your own content.
SanDiegoCuisine.htm

oozeealea [

We don't want to leave this topic empty, so let's add a little bit of text to it. We will add the names of
three famous San Diegans.

Highlight the placeholder text and type Some famous people from San Diego are: and
press Enter.

Type Cameron Diaz and press Enter.
Type Tony Gwynn and press Enter.

Type sally Ride and press Enter.



10. Let's add a bulleted list. Highlight the names of these three famous San Diegans, then select the

Home ribbon at the top of Flare. In the Paragraph section, click . The paragraphs are con-

verted to a bulleted list.

Famous San Diegans

Some famous people from San Diego are:

? Cameron Diaz

” Tony Gwynn
N ” Sally Ride

11. Click IEI to save your work.

CHAPTER 3 | Getting Started Tutorial
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Tip: Notice the left side of the topic. The side structure bars show each element's tag. You may
recognize these tags if you are familiar with XML or HTML. In this topic, we have an <h1> tag
(heading 1), a <p> tag (paragraph text), a <ul> tag (unordered list), and <li> tags (list items).

While you don't need to know code to use Flare, you can use the structure bars to perform a vari-
ety of tasks, including rearranging the items in the topic. After clicking one of these bars and drag-
ging up or down, you will see a blue arrow if you can drop an item somewhere else in the topic. If
you want, click a list item <li> tag and try dragging it up or down in the bulleted list.

Some famous people from San Diego are:

» Cameran Diaz We clicked the "Sally Ride" list
- &J item and dragged it up the list.

» m% You can see the blue arrow

where we can drop it.

» Cameron Diaz

After dropping the
list item, the list
looks like this.

” Tony Gwynn

If you are comfortable with XML and HTML, you can click the Text Editor tab at the bottom of the
topic. The Internal Text Editor lets you make manual changes to the XML.

| FamousSanDieganshtm* * { Ll StartPage *

EIEEEE)

<3xm1 ver

—

- com/ MadCap.xsd" MadCap:lastBlockDepth="4" MadCap:lastHeight

<link hrar="Rescurces/Srylesnests/MainStyles.css” rel="scylesnest” CypesTraxt/css” [

<h1>Famous San Diegans</hlx
<p>Scme famcus pecple from San Diego are:</p>

<u1> Text Editor view

<li3Cameron Diaz</1i>
<1i>8ally Ride</1i>
<li>Tony Gwynn</1id
13 <ful>
13 </pody>
15 B </neml>

MORE INFORMATION

For more information about topics, see the online Help.
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Inserting Images

Let's add an image to a topic to give it a little pizazz. There are already several images saved in this project.
By default, images are saved in the Resources folder, in the Images subfolder.

= Content Explorer w [ =
QD' AN AT N

] Content

v L[] PrintOnlyTopics Images are stored in

the Resources folder.

a [ Resources
a | [ | Images
B[ | AleSmith-Logo.png

B | | balboapark.png
(s Ballast_point_brewing_logo.png

INSERT AN IMAGE

1. Inthe Content Explorer, double-click Food.htm. The topic opens in the XML Editor.

2. Place your cursor at the end of the paragraph about Mexican food (right after "United States."). Then
press Enter. This creates a new line for you to either type a new paragraph or insert other content.

3. Atthe top of Flare, select the Insert ribbon. In the Multimedia section, select Image. The Insert
Image dialog opens.

CHAPTER 3 | Getting Started Tutorial 23



4. Inthe Select File section, navigate to Content>Resources>Images>tacos.png.

Selectthe image you l
want to add to the project.

Select File

Preview

Images in project:

i sl |

over.jpg

L witterlcon.png
[ | MasterPages

You can see a preview

file: f{{C: Users /pstoeddein/Documents My F w ofthe image here.

@ Note: In this case, the image is already in our project, so you can navigate directly to it.

However, if you need to insert an image that is not in the project yet, click - to find the

image on your computer or network.

5. Click OK. Animage of some tacos appears in the project.

6. Click IEI to save your work.
Tip: You can also drag and drop images from the Content Explorer directly into your topic.

MORE INFORMATION

For more information about images, see the online Help.
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Inserting Cross-References

It is fairly common to link to other topics in a project. One way to link between topics is a cross-reference.
You may have noticed several cross-references in this tutorial already.

A benefit of using a cross-reference over a standard hyperlink is that cross-references use format com-
mands to update the link automatically. Format commands allow you to tell the cross-reference to provide
page number information, the title of the topic, or even a file path.

@' Note: In this project and in the San Diego template, the default cross-reference style
(MadCap:xref) creates context-sensitive cross-references. In web-based output, these cross-ref-
erences look like a regular link. In print-based output, the text in the link is based on the rela-
tionship of the cross-reference and the target location (e.g., see "Topic" on page 26, see "Topic"
on the next page).

There is so much delicious fod These cross.references to "Food"

and "Beer" are context-sensitive,

dECiding whatto eatfirst. S andshow relative locations.

fresh seafood, delicio

See "Food" below ad "Beer" on the next page.

We are going to add two cross-references to our project using two different methods: the standard method
and the drag-and-drop method.

CHAPTER 3 | Getting Started Tutorial 25



INSERT CROSS-REFERENCES USING THE STANDARD METHOD

—_

> D

o

26

In the Content Explorer, double-click SanDiegoCuisine.htm. The topic opens in the XML Editor.

At the end of the paragraph, type See . (Be sure to leave a space after See and then type a period.)

Move your cursor back, and click just in front of the final period.

Select the Insert ribbon. In the Links section, select Cross-Reference. The Insert Cross-Refer-
ence dialog opens.

In the Link to: section, make sure Topic in Projectis selected from the drop-down.

In the area below, you can select the topic to which you want to create a cross-reference. Select
Food.htm.



7. Atthe bottom of the dialog is the Cross-Reference Properties section. On the left side of this sec-
tion you can select the cross-reference style you want to use. You can also create a new style or
edit an existing one. The right side shows you the format command and a preview of how the cross-
reference appears in Flare.

Scroll to the bottom of the XRef Class field and notice the style called "MadCap:xref." This is the
default cross-reference style and will be used by default when you insert a new cross-reference.

Link to:
[Tupic in Project

Select Topic in Project

= E A Topic Files (*htm;" -

AllAbout SanDiego htm
Beer htm
Food htm

PO

;"”"&”mm . Select the topic you want to
anbhego rACIons.mm

cross-reference.
SanlieqoCuisine htm

Cross-Reference Properties
#Ref Class: [ Edt... ][ MNew...

This is the default cross-
reference style.

MadCapref ConceptPageMNum fparatext]

MadCapref TOCPage
I MadCaporef —

Food o

1 ||

Target Frame: - Screen Tip:

8. Click OK. Flare creates a cross-reference to Food.htm using the MadCap:xref style.

9. Click IEI to save your work.

CHAPTER 3 | Getting Started Tutorial 2 7



INSERT CROSS-REFERENCES USING THE DRAG-AND-DROP METHOD

Another common way to insert cross-references is using drag-and-drop. This method automatically uses
the main MadCap:xref style, so if you don't need to choose a different style, this is a good way to insert a
cross-reference.

1.

28

The SanDiegoCuisine.htm topic file should still be open in the XML Editor. We're going to add some
text and another cross-reference after the "Food" cross-reference you already added. Your cursor
should be placed between the cross-reference (the word "Food" and the period). You want it to dis-
play as a left bracket.

Like this:
See Food
Not like this:

See Food|

If necessary, you can press the right arrow twice on your keyboard to change a right bracket to a left
bracket.

Facing the bracket away from the cross-reference ensures that the new content you type will not
become part of the link.

Once your cursor is facing the correct way, type and . (Be sure to leave a space before and after
and.)

In the Content Explorer, select Beer.htm and drag it after the word and (just before the period) in the
XML Editor.



4. Ared line appears when you can drop the topic. When the line is in the correct location, release the

mouse button. Flare creates a cross-reference to Beer.htm using the MadCap:xref style.

There is so much delicious food and Here are cross-

references to the Food
and Beertopics, shown
inonline output.

deciding what to eat first. 5an

fresh seafood, deliciou

See Food and Beer.

5. Click IEI to save your work.

MORE INFORMATION

For more information about cross-references, see the online Help.

CHAPTER 3 | Getting Started Tutorial
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Inserting Drop-Down Text

If you have a very long topic, you may want to break up sections of it to make it easier to read. One way to
do this is to add drop-down text. Drop-down text collapses sections of text under a single link in the topic
(called a "drop-down hotspot"). When users click the hotspot in the output, the text expands and they can
see the hidden content. If they click the hotspot again, the text collapses.

INSERT DROP-DOWN TEXT

1. Inthe Content Explorer, double-click SanDiegoAttractions.htm. The topic opens in the
XML Editor.
2. At the end of the first paragraph, press Enter to add a new line. Then type Balboa Park.

3. Use your mouse to select the three elements that relate to Balboa Park: the text you just added, the
paragraph about the park, and the image of the fountain.

4. Select the Insertribbon. In the Text section, select Drop-Down Text.

30



5. Flare creates a drop-down for the text you selected. The text you added earlier (Balboa Park) now
has a special style applied to it (MadCap:dropDownHotspot) to distinguish it as a clickable drop-
down hotspot. All of the content that is included in the drop-down is surrounded by large, light gray

brackets.

_l:l <) [BALBOA PARK

Balboa Park is e the park

are gardens, walking pa

park hosts

This is the drop-down hotspot.

hundreds of events, includin rades, and

guest speakers.

The entire drop-down is
surrounded by brackets.

drop-down indicate the different parts
of the drop-down (the overall
container, the head, and the body).

Let's add drop-downs for the sections about the Zoo and Petco Park.

6. Scroll down in the topic, and before the paragraph about the San Diego Zoo, add a new line and type
San Diego Zoo.

7. Use your mouse to select the three elements that relate to the San Diego Zoo: the text you just
added, the paragraph about the zoo, and the image of the panda.

8. Select Insert>Drop-Down Text to add a drop-down to this section.

9. Scroll down, and before the paragraph about Petco Park, add a new line and type Petco Park.

CHAPTER 3 | Getting Started Tutorial 3 ]



10.

11.

12.

32

Use your mouse to select the three elements that relate to Petco Park: the text you just added, the
paragraph about the ballpark, and the image of the ballpark.

Select Insert>Drop-Down Text to add a drop-down to this section.
Click IEI to save your work.
Note: Drop-down effects are supported only in online outputs. You can still have them in your top-

ics if you plan to generate print-based outputs, such as PDF. However, it will just look like regular
text.

In online output, drop-downs use a
dynamic text effect. When you click
the hotspot, it expands to reveal

Zoo, and Petco Park. hidden content.

There are many places to w

BALBOA PARK
SAN DIEGO Z00O

PETCO PARK

Drop-down contentis still available

in printed output, but the dynamic
There are many places effects are disabled. The textis
Diego Zoo, and P T expanded and the hotspotlink is

removed: only the textis shown.
BALBOA PARK

Balboa Park is a 1200 acre park in the middle of downtown San Diego. Inside the p
are gardens, walking paths, and more than a dozen museums. Every year the park

hundreds of events, including concerts, marathons and races, festivals and paradeg

We'll talk more about this in "Using Conditions" on page 58.



@ Note: If you have been following this tutorial in order, there is not an online target in the project

yet. However, we'll revisit these drop-downs when we build HTML5 output. See "Creating a New

Target" on page 56 and "Building HTML5 Output" on page 82.

MORE INFORMATION

For more information about drop-downs, see the online Help.
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Using Snippets

You can use snippets in your project whenever you need to use a chunk of content more than once, rather
than rewriting content. Then, when you need to make a change, you can change the content in the snippet
and the change will appear wherever you used the snippet. You don't need to make the same change mul-
tiple times.

A snippet can be as short or long as you want. It can be just a few words, a sentence, or several para-
graphs. Snippets can contain any type of content, including text, images, lists, or even other snippets.

Let's create a short snippet and place it in our project.

CREATE A SNIPPET

We will use Home.htm as the landing page when we set up an HTMLS5 target (see "Creating a New Target"
on page 56 and "Building HTML5 Output" on page 82). There is good introductory information on this page
that we can also use as an introduction in AllAboutSanDiego.htm, which will be the first topic in our

PDF output (see "Building PDF Output" on page 85). Let's create a snippet so we can reuse this text.

1. Inthe Content Explorer, double-click Home.htm. The topic opens in the XML Editor.
2. Scroll down so you can see the gray area that contains a heading, three short paragraphs, and a list.

3. Select the first and second paragraphs and the entire list (the text starting with "San Diego" and end-
ing with "San Diegans").

Welcome

Selectthis
content

Take look around and get to know us! We're glad you stopped by

4. Select the Home ribbon. In the Snippet section, select Create Snippet. The Create Snippet dialog
opens.
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5. Inthe Snippet File field, type SanDiegoIntro. This is the name for your snippet.

6. Inthe Project Folder field, you can enter a location where you want to save your snippet. By
default, snippets are saved in the Content folder in the Resources/Snippets folder. This is the recom-
mended location for snippets, so we will not change this path.

7. Inthe Snippet field, use the scroll bar to review the content. You should see exactly the content you
just selected (the text starting with "San Diego" and ending with "San Diegans").

@ Note: The preview won't have any styling associated with it, so it will look somewhat
plain. That's okay. The styles will show up in whatever topic the snippet is inserted into.

But if anything else looks incorrect in the preview, you can click Cancel and start again.

8. Make sure the check box Replace Source Content with the New Snippet is selected. Since we
want to use the snippet in the current topic, this will automatically insert the snippet into that topic

for us.
Snippet File: SanDiegolrtrol
Project Folder: Resources/Snippets. -
Snippet: -
San Diego is a beautiful place to live, I
worlk, and visit. This guide will introduce | =
vou to America's Finest City. e

In this guide, you will learn about:

Replace Source Contert with the Mew Snippet
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9. Click Create. Flare creates the snippet, inserts it into the topic, and adds the snippet file to the Con-
tent Explorer. Notice that the structure bars on the left side of the content (representing the indi-
vidual paragraphs and the list) have been replaced by a single structure bar (i.e., the snippet block),
and the snippet is surrounded by light gray brackets.

Theindividual structure
bars have been replaced
by a single structure bar.

The snippetis

surrounded by
brackets.

n Diego is a beautiful place to live, work, and visit. This guide will infroduce yol merica's
Finest City.

In this guide, you will learn about

# San Diego history

» Local attractions

» Delicious food and drink
» Famous San Diegans

10. Click E' to save your work.
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INSERT A SNIPPET

Now that we have created a snippet, we will insert it into another topic.

1.
2.

In the Content Explorer, double-click AllAboutSanDiego.htm. The topic opens in the XML Editor.

Click at the end of the All About San Diego heading and press Enter to create a new empty para-

graph after it. This is where we will insert the snippet.

Select the Insert ribbon. In the Single Source section, select Snippet. The Insert Snippet Link dia-

log opens.

In the Select Snippet section, navigate to Content>Resources>Snippets>SanDiegolntro.flsnp.
When you select the snippet, you will see it in the Preview section so you can confirm that you have

selected the correct snippet.

Select Snippet
I lE * flsnpr*.mcsnp -
— Content
» [][] PrintOniyTopics Selectthe
P Resources snippet you

Images
MasterPages
Pagelayouts
Snippets
Q SanDiegolntro flsnp
Stylesheets
TableStyles

want to insert.

vavl‘l_

DLED

[T

Pinned Snippets
Recently Used Snippets

1T

|‘ SanDiegolntro ../Resounces/Snippets/

file:#//C:/Users/patoecklzin/Documents/My Projects/San Diego/Cor

Preview

San Diego is a beautiful place to
live, work, and visit. This guide will
infroduce vou to America's Finest
City.

In this guide, you will learn about:

« San Diego history

+ Local attractions

« Delicious food and drink
+ Famous San Diegans

A

You can see the
snippet contentin
the Preview section
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5. Click OK. The snippet appears in the topic between the heading and the History section.

All About San Diego

-San Diego is a beautiful place to live, work, and visit. This guide will infroduce you to
America's Finest City.

In this guide, you will learn about:

” San Diego history

The snippet is added to

” Local aftractions the topic.

” Delicious food and drink

? Famous San Diegans

History
& fHISTORY g

San Diego was incorporated in 1850, the same year California became a state.

6. Click IEI to save your work.

Tip: You can also drag and drop snippets from the Content Explorer directly into your topic.

Tip: If you need to edit a snippet, you can double-click it in the Content Explorer. It will open in the
XML Editor just like a topic. However, if you end up with many snippets over time, it might be dif-
ficult to locate the precise snippet you need. A quicker way to edit a snippet is to right-click on a
snippet that is inserted in a topic and from the context menu select Open Link.

MORE INFORMATION

For more information about snippets, see the online Help.

33



Inserting Tables

You can use tables for many purposes in Flare. We are going to insert a small table into a topic to compare

some information.

INSERT A TABLE
1. Inthe Content Explorer, double-click AllAboutSanDiego.htm. The topic opens in the XML Editor.
2. Scroll down to the History section of the topic. Add a new empty paragraph between the two para-
graphs in this section.
3. Select the Insert ribbon. In the Table section, select Table (the face of the button, not the down
arrow). The Insert Table dialog opens.

@ Note: If you click the down arrow below the Table button, it will open a grid that you can
use toinsert a basic table. That is fine for many uses, but for this tutorial, be sure to click
the face of the button—not the arrow—so you can configure some properties in the Insert

Table dialog.

A

Click the face of the
button to open the
Hyperlink Cross-Reference Bef Insert Table dialog.

Insert View Project Review Tools Table

@i Screen Capture
ZE QR Code

Slideshow

Links
However, you can also
use the arrow below the
table button to quickly
add a table thatis not
formatted.

All About San Diego
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4.

40

In the Table Size section, use the arrows to make the following changes:

a. Set the Number of columns to 2.

b. Setthe Number of rows to 4.

c. Setthe Number of header rows to 1.

As you change these settings, the table in the Preview section updates to show you how your table

will appear in Flare.

Table Size
Mumber of columns:

Number of rows:

Mumber of header rows:

Number of footer rows:

Table Caption

Text:

AutoFit Behavior

: () AutoFit to contents

) AutoFit to
, Adjustthe
Table Size

settings.

Align

| (defait)

Table Style
@ Table Style:

Side: |Below table

<)

[ (default)

Repeat: [[default)

'] () Style Class:

Continuation: (default]

Summary

Preview

Previewthe
fable.

Cther:




5. Inthe Table Style section, from the Table Style drop-down, select BasicAlternateRows.css.

As you change these settings, the table in the Preview section updates to show you how your table

will appear in Flare.

Table Caption
Table Style

Text:
@ Table Style:

Side: When youapply _
a Table Style__ |BasicAlternateRows - U: Tutorial\sanDie¢ +| i ~
Repeat: ) Style Class:
Continuation: (default) - | - |
Summary Text to Table
- @ Mone Commas
— Paragraphs Tabs
Preview

__the preview
changes.

6. Click OK. The empty table appears in the History section.
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10.

Let's add some data to our table.

Click in the top left cell of the table. This is your header row. Type Historical Affiliation.

Click in the top right cell of the table. Type Date.

In the Historical Affiliation column, type the following:

a.
b.
c.
d.

In the first cell, type Spanish Empire.
Inthe second cell, type First Mexican Empire.
Inthe third cell, type United Mexican States.

In the fourth (bottom) cell, type United States.

In the Date column, type the following:

a.
b.

C.

In the first cell, type 1769-1821.
In the second cell, type 1821-1823.
In the third cell, type 1823-1848.

In the fourth (bottom) cell, type 1848-present.

N N

Spanish Empire 1769-1821
First Mexican Empire 1821-1823
United Mexican States 1823-1848
United States 1848—present

11. Click IE| to save your work.
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WHAT ARE TABLE STYLES?

Flare uses table styles to determine the look of a table. They are a useful way to make sure all of your
tables have a consistent look. For example, you can use a table stylesheet to determine the colors for your
table's rows and columns, or for its borders. You can apply the table style to one table or to all of the tables
in your project. Table styles are handled separately from regular stylesheets.

You can also use table styles to set default styles for the cell content. In the table style we applied, the
header row is bold and centered (p. TableTextHead style class), while the rest of the rows are left-aligned
and normal weight (p.TableText style class).

Spanish Empire This contentis using the

=1 p.TableTextHead style class.
First Mexican Empire TEZ =102
United Mexican States 1R ARAR

= This content is using the p TableText
United States style class.

MORE INFORMATION

For more information about tables and table styles, see the online Help.

CHAPTER 3 | Getting Started Tutorial 43



Editing Variables

Variables contain short pieces of information that appear throughout a project, like your company name,
website, and product name. You can create variables for just about anything. Variables work sort of like
shippets: you can use them throughout your project, and when you make a change to them, the changes
will appear anywhere you used the variable. This makes variables a great option for information that might
change frequently, such as dates or version numbers.

When you create a new project, Flare automatically adds a few standard variables to your project. Let's edit
some of these variables so our finished project will be a little less generic.

EDIT A VARIABLE

Up to this point, we have been working with resources that are stored in the Content Explorer. Variables are
a project resource, so they are located in the Project Organizer.

1. Open the Project Organizer.
2. Expand the Variables folder.
3. Double-click the General variable set. The Variable Set Editor opens to the right.

Look at the different variables in this project. There are variables for the company name, street
address (including a separate variable for the city, state, and zip code), phone number, website, and
current year. There is also a variable for the name of the guide.

The name of each variable appears in the Name column. The content that will appear wherever the
variable is used appears in the Definition column. Let's edit some of the variable definitions.
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4. Inthe Definition column, double-click My Company, LLC. In the field, enter the name of your com-
pany and press Enter.

VariableSet Editor % % | % | o4 2 x =
MName 4 Defintion Comment
CityStateZip La lolla, CA 92037

i )

CompanyMame | MadCap Software

GuideTitle All About San Diego

;=h' PhoneMumber |83 123 4367

=] | StreetAddress 1234 Lorem lpsum

=] | Website http:/fwww.madcapsoftware.com
% Year YYYY

5. (Optional) In the Definition column, double-click and change the definition for any other variables
that you want to customize.

@ Note: You might have noticed that the Year variable has a slightly different icon, which

uses a clock . This indicates that it is a Date/Time variable. Date/Time variables use

format specifiers to represent the date or time. The Year variable uses the format "yyyy" to
represent the current year (in 4-digit format).

Edit Format ?

Enter Fomat Specifiers: Update:

oo | | on Buid

Result: 2016

For more information about formatting and using Date/Time variables, see the online Help.

6. Click E' to save your work.
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EXAMPLE

After you finish renaming variables, you can look at them in a topic. Open the Content Explorer,
then expand the PrintOnlyTopics folder. Double-click Copyright.htm.

¢ CompanyNa MadCap Software 3

3 :.S“t;éebﬂ.ddrES 1234 Lorem Ipsum g
B Elh,'SlateEm: La Jolla, CA 92037 3
& PhoneNumb 858 123 4567 3

These are some of the
variables inthe Copyright
topic, including the
CompanyName variable
thatwe just changed.

E Website: mpﬂmw;madcapsnﬂma{e_mnﬂ

information.

on page 85.

All of the gray highlighted fields on this page are variables. Using the Show Tags drop-down

field in the local toolbar of the XML Editor, you can adjust your markers to display inserted variables
in different ways (e.g., show/hide the variable name in the editor).

If you were to edit the variables again, and then come back to this topic, you would see the updated

We will use this topic again later when we build a PDF from this project. See "Building PDF Output"

MORE INFORMATION

For more information about variables, see the online Help.
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Making It Look Good

There are lots of ways in Flare to make your output look good. In this tutorial we're going to
focus on the most common way to control the look of your documentation—styles.
However, keep in mind that this tutorial only scratches the surface of how to use styles.

This chapter discusses the following:

Creating Style Classes ... 48
Applying Styles il 5}

CHAPTER 4
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Creating Style Classes

You can use styles in your projects to format elements. While you can use local formatting (such as select-
ing a single word and using the Color button on the Home ribbon to make it red), using styles will save you
time. If you change the properties for a style in the stylesheet, that change will be made anywhere you used
the style class. You do not need to go back and make the change in every topic.

After you create a new Flare project, you'll see that there are already many styles for you to use. And you
can change the properties for any of those styles to adjust the look.

In addition to using the styles that are already in place, you may find the need now and then to create your
own style class. Think of a style class as a "child" of a "parent" style. A style class gives you more flex-
ibility when using a style. For example, you might create ared h1 (heading 1) style class and a blue h1 style
class. These would both be children of the h1 style (e.g., h1.red, h1.blue).

CREATE A STYLE CLASS
We are going to create a style class of the parent image (img) style. Then we will modify our style class so
that it turns online images into thumbnails. In other words, images will initially display very small but when
they are clicked in online output, they will be shown at the full size in a popup.

1. Inthe Content Explorer, open Resources>Stylesheets.

2. Double-click the MainStyles.css stylesheet. The Stylesheet Editor opens to the right.

3. You can use the Simplified or Advanced view when editing a stylesheet. Let's use the latter. In the
local toolbar of the Stylesheet Editor, make sure the first button is labeled View: Advanced. If it
says View: Simplified, click it so that it change to the Advanced view.
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4. Inthe upper-left corner of the editor, make sure the drop-down is set to

| Image Styles -
Stylesheet Editor § View: Advanced | % Add Selector Manage Font Sets  Options -
Image Styles - | Hide Inherited (= | Medium: (default)
img
MadCap | model3D

object

5. Inthe Styles section, select img.

6. Inthe local toolbar of the editor, click | =_Add Selector| The New Selector dialog opens.

CHAPTER 4 | Getting Started Tutorial
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7.

50

In the Class Name field, type thumbnail.

Mew Selector

Manually add selector or choose Options.

HTML Element Class Mame
img - thumbnail
@ Advanced Options
Advanced Selector
img.thumkbnail
Pseudo Class Pseudo Class Expression
Pzeudo Element Identifier (11
Comments
QK | | Cancel




8. Click OK. The thumbnail style class appears in the stylesheet, indented under the img parent style.

Image Styles " [ ] Hide Inheri

4 j

thumbnail
MadTap Tmodel3D

oDject

The style class is added, but the only properties it has right now are the ones it has inherited from
the img style. Now we need to add unique properties to the thumbnail style class.

9. With the new thumbnail class selected, from the Show field in the upper-right cormner of the editor,
|Sh|::-w: Assorted Relevant Properties

select . | This will display only the properties that are related to

images, making it a lot easier to find the properties that you need to set.

Stylesheet Editor S‘ View: Advanced | % Add Selector Manage Font Sets  Options ~

Image Styles ~ Hide Inherited =) ' Medium: (default) ~ | Show: Assorted Relevant Properties ~

4 im

Block
Border

Biox

Cell
Pasitioning
Padding
Thumbnail

MadCap | model3D

object
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10. Make sure the properties on the right side of the editor are shown in group view, which means there
will be different categories that you can expand and collapse. In the local toolbar, you should see a

Grouped View button . If instead you see the Alphabetical View button , click it to switch

to Group View.

Stylesheet Editor | View: Advanced | % Add Selector Manage Font Sets  Options ~

Image Styles ~  Hide Inherited | Medium: (default) ~  Show: Assorted Relevant Properties ~

thumbnail

MadCap | model3D Block
object Baorder

Box

Cell
Pasitioning
Padding
Thumbnail

11. Expand the Thumbnail group.

12. Next to the me-thumbnail property, click the drop-down and select popup. We will leave the other
thumbnail settings as they are.

I Block

I Border

I Box

o Cell

I Positioning
I Padding

4 Th i
| mec-thumbnail: [pnp-up - ]

mec-thumbnail-max-height: |43l5=lx | |

mc-thumbnail-max-width: |E"-'1I' | |

13. Click E' to save your work.

MORE INFORMATION

For more information about styles and creating classes, see the online Help.
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Applying Styles
Now that we have created the thumbnail style, we can apply it to an image.

APPLY A STYLE

1. Inthe Content Explorer, double-click SanDiegoAttractions.htm. The topic opens in the
XML Editor.

2. Select the Home ribbon. In the Styles section, select Style Window. The Styles window pane
opens on the right side of the Flare interface.

The Styles window pane displays formatting options for the text that is currently selected. For
example, if you have clicked in a paragraph, you will see several styles for formatting text, such as
heading styles and any children of the parent p style.

3. Inthe XML Editor, select the image of the fountain. In the Available Styles section of the Styles
window pane, the style that is currently applied to the image of the fountain (i.e., the img style) is
shown at the top and highlighted in the list below.

Styles v I x

Current Style and Local Formattin

Thisisthe
current style.

mg

| EditStyle || Createstyle.. |

Available Styles

The current
style is | 0
highlightedin P\ resetcless
the list. 1"’”21 " r Our new style

img.thumbnail classis also
available.
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4. Inthe Styles window pane, click img.thumbnail. In the XML Editor, the image of the fountain
shrinks to the dimensions for the thumbnail (as specified in the stylesheet).

= PBALBOA PARKY

The img.thumbnail
style class has been fle of g
applied here...

Balboa Parkis a
walking path

includin certs, marathons and races, festivals

= pSANDIEGO Z00 3

The San Diego Zoo was j
_but not here.

3700 rare and endangy

5. Apply the img.thumbnail style to the image of the panda and the image of Petco Park.

6. Click IEI to save your work.

@ Note: If you want, you can apply the img.thumbnail style to other images in the San Diego

project.

MORE INFORMATION

For more information about applying styles, see the online Help.
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CHAPTER 5

Developing Targets

After your project is styled, you are ready to start preparing your output files. You can set up
different output types (e.g., PDF, HTML5, EPUB) and define settings that tell Flare what
information to include in the final documents.

This chapter discusses the following:

CreatingaNew Target ... ... . 56
Using Conditions ... .l 58
Working With SKINS . 68
Usinga Tableof Contents ... ... ... . 75
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Creating a New Target

When you want to produce a new kind of output, you need to add a target to your project. A target is a single
instance of an output type, such as a PDF, an online Help system, an eBook, or a Word document. You
can create as many targets as you need to.

Right now, the San Diego project is set up so you can build a single PDF target. However, we also want to
create an online target. The type of online output we recommend most is HTML5.

CREATE A NEW HTML5 TARGET

1. Inthe Project Organizer, right-click the Targets folder. From the context menu select Add Target.
The Add File dialog opens.

2. Inthe Add File dialog, you can select the kind of target you want to create. In the Source area, make
sure that New from template is selected, then select MyTarget from the list of factory templates
(this should be selected by default). This will create a new target with default settings selected.

3. From the Output Type drop-down, select HTMLS5.

4. Inthe File Name field, enter2A11 About San Diego HTMLS.

File Type:

(@ Target -
Source Description
@ New from template: New Target -

4| Factory Templates
(&) MyTarget
|| 5anDiego_Template

D)
() Mew from existing:
Selectthe
(-] output type you —
want to create.
Target Entera name
Folder: forthe target. Qutput Type:
{root folder) (o] [l HTMLS -

File Name: S
All About San Diego HTMLS

5. Click Add. The new target is added to the Targets folder in the Project Organizer.
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SET THE STARTUP TOPIC FOR A TARGET

We will use a special topic for the landing page (Home.htm) in our online target.

1. The editor for your new target should already be open. But in case it isn't, double-click the All About

San Diego HTMLS5 target in the Project Organizer.

2. Inthe Target Editor, select the General tab.

3. Next to the Startup Topic field, click [:] The Link to Topic dialog opens.

4. Inthe list of topics, select Home.htm.

5. Click Open. Home.htm is now associated as your target's startup topic.

Target Editor | /%) Build ) View - & Publish

4 Open Build Log

General

Skin
Conditional Tet
Variables
Publishing

Glossary

Fiolab: Lo L

|

Qutput Type:

Comment:

[, HTML5

Mew Target

Startup Topic:

[Content/Home. htm

Master TOC:

Master Stylesheet:

(default)

(default)

Allow local stylesheets

Edit

Edit

6. Click IEI to save your work.

Note: The home page we are using for our HTML5 startup topic uses its own stylesheet and mas-
ter page (these things are already set up for you). This is why it has a different look and feel than

the other pages. If you want to learn more about how to configure the settings for HTMLS5 output,
refer to the Top Navigation Tutorial in the online Help.

MORE INFORMATION

For more information about targets, see the online Help.
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Using Conditions

You may have noticed red and blue indicators on some drop-downs and headings in the San Diego project
(take a look at Food.htm to see some). These colors indicate condition tags. The San Diego project has
condition tags set up for printed and online output.

APPLY CONDITION TAGS
1. Inthe Content Explorer, double-click AllAboutSanDiego.htm. The topic opens in the XML Editor.

2. Scroll down to the History section of the topic.

Notice that the History section contains both a drop-down and a Heading 2. As we discussed in
"Inserting Drop-Down Text" on page 30, the drop-down effect only works in online outputs. Although
we could use a drop-down as static text in our PDF, we will use the Heading 2 instead. It will work
better with the PDF's built-in bookmarking features. We will use the drop-down in the online output.

This section includes I

a Heading 2.
History ’% ]

E BHISTORY g

San Diego was | _and a drop-down. Wear California became a

state. However, before Spanish Empire, First

Mexican Empire, and Mexican United States.
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In order to tell Flare which text to use in which output, we will assign condition tags to each element.
3. Right-click the word History used for the Heading 2.
4. From the context menu, select Conditions. The Condition Tags dialog opens.

In this dialog, you can see the Default condition tag set. There are two conditions in the set:

PrintOnly and ScreenOnly.
Condttion Tag Sets - Condition Tags & Comment
Defautt PrintCinby
ScreenOnly [F
( Edit Set ] Unselect A | SelectAl |

@ Note: In your own project, you can create as many condition tag sets and conditions as

you need. And you don't need to use the ones provided in the Default condition tag set.
They're simply a starting point for you.

5. Since we want this heading to appear in our PDF, select the check box next to PrintOnly.
6. Click OK.

If you have markers turned on, the entire Heading 2 is highlighted red.

h2

Historﬂ

[ BHISTORY g

The PrintOnly condition has

been applied. ame a

First

San Diego was incorporated in 1
state. However, before that, it had b
Mexican Empire, and Mexican United States.
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10.

60

=]
@ Note: You can turn conditional indicators on and off by clicking in the bottom toolbar of

the XML Editor.

Click IEI to save your work.

Now we will apply an online condition tag to the drop-down hotspot. But this time we're going to do it
a little differently. Conditions can also be associated with styles, so we're going to use that method.

In the Content Explorer, navigate to Resources>Stylesheets and double-click MainStyles.css.
The Stylesheet Editor opens.

In the local toolbar, click Add Selector. The New Selector dialog opens.

Previously in this tutorial, we created a class of the parent img style (see "Creating Style Classes"
on page 48). But now we're going to create something called a "generic style class." This class will
not be directly associated with any parent style, which means that any parent style can use it. In the
HTML Element field, clear any text init.



11. Inthe Class Name field, type OnlineOnly.

Mew Selector

Manually add selector or choose Options.

HTML Element

Class Mame

~ OnlineQnly

@ Advanced Options

Advanced Selector

OnlineCnly

Pseudo Class

Pzeudo Element

Comments

Pseudo Class Expression

Identifier (11

QK | | Cancel

12. Click OK.
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13. Inthe Stylesheet Editor, click in the drop-down in the upper-left corner and select All Styles.

T

Stylesheet Editor | as) View: Advanced | % Add Selector Manage Font Sets  Options ~

All Styles = | Hide Inherited =) < Medium: (default)

(Linked Stylasheets)
[ [Generic Classes)

I [Generic Pseudo Clazses) I Block
(ldentifizrs) I Border

I [Complex Selectors) I Box
{Custom Lists) [+ Cell

I* a I* Positioning
abbi I Padding
acronym I Thumknail
address
area
article

14. Inthe list of styles below, expand (Generic Classes).

15. Select OnlineOnly, the class you just created.

by

Stylesheet Editor | as| View: Advanced | % Add Selector  Manage Fof

All Styles *  Hide Inherited (=] v

(Linked 5tylecheets)
4 [Feneric Classes)

[ [Generic Pzeudo Classes)
(ldentifiers)

I [Complex Selectors)
(Custom Lists)

I a

1]
o
=

[=1]

M

1
=
o |

3

=TI =1}
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16. Inthe Show drop-down field in the upper-right corner, select Show: All Properties.

Stylesheet Editor | @ Wiew: Advanced | % Add Selector Manage Font Sets  Opticns -
All Styles ~  Hide Inherited Medium: (default) ~ | Show: All Properties =
[Linked Stylesheets) ~
4 [Generic Classes)
CnlineOnly I Font
I {Generic Pseudo Classes) I Background
(ldentifiers) I Blodk
I {Complex Selectars) I Border
(Custom Lists) I Box
b a I Cell
abbr I List
acronym I Table
address I Pasitioning
area I Extensions

17. Expand the Unclassified group below.

Stylesheet Editor | @ View: Advanced | % Add Selector Manage Font Sets  Options »
All Styles ~  Hide Inherited Medium: (default) ~  Show: All Properties ~
4 [Generic Classes)
CnlineOnly I Redaction
I {Generic Pseudso Classes) I DITA
(ldentifiers) 4 Unclassified
I (Complex Selectors) box-shadow:
[Custom Lists)
I a box-sizing: -
abbr
content:
acronym
address counter-increment:
area
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18. Scroll down until you find the mec-conditions property and click E] to the right of it. The Condition
Tags dialog opens.

Stylesheet Editor a View: Advanced | % Add Selector  Manage Font Sets  Options =

All Styles ~ Hide Inherited = | Medium: (default) ~  Show: All Properties ~

(Linked Stylesheets)
4 [Generic Classes)

(Complex Selectars)
(Custom Lists)

I a

abbr

acronym

address

area

me-community-features

mec-concepts-list-headings

Dnl_inEOnIy mec-closed-image-alt-text
I {Generic Pseudo Classes)
(ldentifiers) mc-column-count: [ - ]

mc-conditions:

mc-disable-glossary-terms:

19. Since our new generic style class is intended for online content only, select the check box next to
ScreenOnly.

20. Click OK.

21. Click IEI to save your work.

22. Now we will apply that new generic style class to the drop-down in our topic. Go back to the
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23. Right-click the drop-down structure bar just to the left of the History drop-down hotspot.

e

Right-click on this
structure bar.

ha|

HistoryI
= [HISTORY g

San Diego was incorporated in 1
had been part of the Spanish Em

Snanish Fmpire

24. Inthe context menu, select Style Class and then choose .OnlineOnly.

o]y

i History
[EI FHISTORY g 2] Create Style Class...
<MadCap:dropDownHead= Edit Style Class
Unbind Drop-Down Text... Reset Style Class
3 Paragraph... Ctrl+Alt+B OnlineOnly
(Al Font. Ctrl+Shift+ B TableStyle BasicAlter
E Style Class b
Style ID 3
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25. A blue box appears next to the word "History" in the drop-down. If you have conditional indicators
turned on, the entire drop-down heading is highlighted blue.

History

= mFHISTORY §

The OnlineOnly style class
hasbeen applied.

S5an Diego wa

had been part of the Spa

This second method might seem like a lot of steps, but remember, creating the style class and asso-
ciating a condition with it is a one-time setup. Once that is done, you can apply the generic style
class to any parent tag (e.g., p, ol, img) that you want to be shown only in online output. And that's a
very quick task.

26. (Optional) You can also apply conditions in the Climate section below in the topic.

27. Click E' to save your work.

Note: If you added drop-down text and Heading 2s to the San Diego Attractions topic (see "Insert-
ing Drop-Down Text" on page 30), you can go back and add conditions to this topic as well.

This is not a requirement, though. In fact, you may want to build the PDF output twice—once
before adding the headings and condition, and again after you add them—to see the difference
between a heading and a drop-down in printed output.

Tip: You can also preview the topic to see your changes. In the local toolbar of the XML Editor,

click . Preview both the PDF and the HTMLS5 target to see the differences. If you preview the

HTMLS5 topic, you might notice that you see both the drop-down headings and the Heading 2s.
That is because you have not yet associated conditions with that new target.
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ASSOCIATE CONDITION TAGS WITH A TARGET

You have applied condition tags to your topic, but they won't do anything if you don't also associate them
with the targets you are going to build. Associating the condition tags with a target tells the Flare which con-
ditions to include or exclude when building the output.

We have already associated conditions with the PDF target for you. But you still need to associate con-
ditions with your new HTMLS5 target.

1.

In the Project Organizer, expand the Targets folder.

2. Double-click the All About San Diego HTML5 target. The Target Editor opens to the right.
3. Select the Conditional Text tab. This tab allows you to select which conditions will be included and
which will be excluded from the output.
4. Next to the Default.PrintOnly condition, select the Exclude check box. We do not want to see con-
tent marked with the print condition in the HTMLS5 target.
5. Next to the Default.ScreenOnly condition, select the Include check box. We do want to see con-
tent marked with the screen condition in the HTMLS target.
Taos _ Indude Exdude
Default, PrintOnly [
Default, ScreenOnly [l
6. Click E' to save your work.
MORE INFORMATION

For more information about conditions, see the online Help.
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Working with Skins

When you are using an online output, you will want to give some structure and style to the page. Skins are
a pre-designed look and feel for the final output. They let you set the logo, colors, fonts, and more for the
area that surrounds the main topic content.

We could have discussed skins earlier in "Making It Look Good" on page 47, but skins need to be linked to
an online target and we hadn't created our HTML5 target yet. So we'll take a look at skins now.

@ Note: You will find that many of the tasks in this tutorial don't necessarily have to be done in a pre-
cise order. For example, there might be times when you are near the end of your project, preparing

to generate the final output (the final step in the overall process), but you decide to add a few new

elements and some content (step 2 in the overall process) before doing so.

SET A LOGO IN THE SKIN
There are many things you can do to give your skin its own style. One of the first things you will probably do
when setting up a skin is put your company or product logo in your skin. Let's put a logo in our skin.

1. Inthe Project Organizer, expand the Skins folder.

2. Double-click the HTMLS - Top Navigation skin. The HTMLS5 Skin Editor opens to the right.

3. Select the Styles tab. The skin styles are on the left side and a dynamic preview area is shown on

the right side. By dynamic, we mean that you can actually click in the preview area and navigate to
different parts of the skin.

Also notice the three mediums at the top of the editor (Web, Tablet, and Mobile). These let you
provide different style settings for the skin, depending on the size of the device. In this tutorial, we're
only going to concern ourselves with the Web medium, so we'll keep it selected.
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HTMLS Skin Editor | Preview [| Web Medium | Tablet Medium Mobile Medium | Highlight

Setup Global -

Community I Main Page

Styles Header
I Text | Header

Search

I Logo

I Search Bar
" Search Input Your search for "
I Search Filter

I Search Filter [sslected)

Topic

I Search Filter Drop-down

You should be able to see the default logo in the preview area.

HTML5 Skin Editor | Preview | Web Medium | Tablet Mediurn Meobile Medium | Highlight

|

Setup

Community I Main Page
Header

g
3

Ul Text I Header

Search

I Logo

I Search Bar
" Search Input Your search for "
I Search Filter

I Search Filter (selected)

Topic

I Search Filter Drop-down
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4. The Logo group is pretty easy to spot on the left side of the editor. But sometimes it can be a bit
more difficult to find the style you need to change. So here's a little trick. In the local toolbar of the
editor, click Highlight.

/0

Setup

Community

Ul Text

HTMLS Skin Editor | Preview || Web Medium | Tablet Medium Mabile Medium || Highlight I

ot

Main Page

Header

Header

Logo

Search Bar

Search Input

Search Filter

Search Filter (selected)

Search Filter Drop-down

Your search for

Topic




5. This button synchronizes the styles on the left with whatever you click in the preview area. Let's try
it. In the preview, click the logo.

The Logo group on the left is selected and expanded. Now you know the general area where you
need to make your changes.

HTML5 Skin Editor | Preview || Web Medium | Tablet Medium Mcbile Medium || Highlight

Community I Main Page

e

Ul Text I _Header

Search

I Alignment

I Background Your search for "
I Layout

I Search Bar

I Search Input Topl c
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6. Under the Logo section, expand the Background section.

Setup

Community

Styles

Ul Text

Gobal R

I Main Page

I Header

l‘_

I Alignment

4 Background

Gradient: transparent ¥ | 3 %
tramsparent ¥ _Z

Color |tmn5parent L |_'2|_:

Image: url{'resources:WebHelpZ/Desl |k |

I Layout
I Search Bar

I Search Input

7. Next to the Image field, click (=] The Insert Image dialog opens.

8. Inthedialog, click E]
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9. Inthe Open File dialog, navigate to...\Documents\MyProjects\San Diego\Con-
tent\Resources\Images. Then select SanDiegoLogoTransparent.png.

@ Note: This is the location for the logo if you used the project settings in "Creating a Project
from a Template" on page 10. Otherwise, you can locate the logo in the location where you

saved the San Diego project file.

10. Click Open.

11. Click OK. The logo appears in your skin. You can see the preview of how the logo will look in the
final output on the right side of the HTML5 Skin Editor.

it = ALL ABOUT

ons SA@GO

CALIFORNIA

Header

" Header

4 |logo

b Alignment

4 Background

Thelogo
Gradient: transparent ¥ E =/ | previewedin
wanzparent v |L3] £ theskin. Your search for "topic
Color: transparent ¥

Image: SanDiegologoTransperentpng  w @

Topic

© Layout

12. Click E' to save your work.

@ Note: In this project, alogo also appears in the Home Page master page, which controls the look
of the home page. This logo has already been set up for you, but if you want to view it or change it,

you can open the master page in your Flare project by navigating to Con-
tent>Resources>MasterPages>HomePage.flmsp.
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ASSIGN A SKIN TO A TARGET

Now that we've created the skin, we can assign it to the HTMLS5 target we created.

1. Inthe Project Organizer, expand the Targets folder.

2. Double-click the All About San Diego HTMLS5 target. The Target Editor opens to the right.
3. Select the Skin tab.
4

In the Skin field, select HTMLS5 - Top Navigation.

Target Editor | 5 Build 3 View ~ [ Publish |, Open Build Log
i
General General
Skin: HTML5 - Top Navigation W
Skin
Component Default Skins
Conditional Tet
Menu: (default) W
Variables
Topic Toolbar: (default) W
Publishing

5. Click IEI to save your work.

MORE INFORMATION

For more information about skins, see the online Help.
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Using a Table of Contents

Let's create a table of contents (TOC) to organize the topics that will go into our targets.

But as you do this, keep something very important in mind. A TOC file in online output acts as your online
navigation. But for print-based outputs, a TOC file acts more like an outline; it's simply used to tell Flare
which topics should be included in the print output and in what order. The actual generated TOC in print-
based outputs is done a bit differently. It uses something called a"TOC Proxy." See the online Help for

more information.

In the San Diego template, there are two TOC files already created for you: one for printed output and one
for online output. Since we added a topic to this project earlier (FamousSanDiegans.htm; see "Creating
Topics" on page 18), we need to add that topic to these TOCs before we can build our outputs.

ADD A TOPIC TO THE ONLINE TOC

1.

2
3.
4

In the Project Organizer, expand the TOCs folder.
Double-click Online TOC. The TOC Editor opens to the right.
Open the Content Explorer.

In the Content Explorer, select FamousSanDiegans.htm and drag it to the TOC Editor on the right.
You will see a blue arrow when you can drop it. Drop the topic under San Diego Cuisine.

— Online TOC
TOC Editor E Views Tree s

[ [ ] Al About San Diego
5an Diego

Crop Famous San Diegans here.

— Online TOC*
TOC Editor B View: Tree =
All About San Diego

5an Diego Attractions
San Diego Cuisine

> |

Famous 5an Diegans
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@' Note: This topic should appear under San Diego Cuisine, but not on the same level as
Food and Beer. If Famous San Diegans drops on the same level as Food and Beer, use the

blue arrow in the local toolbar of the TOC Editor to move it to the same level as San

Diego Cuisine.

= Online TOC*
TOC Editor i 3 View: Tree
[ ] All About San Diego
M San Diego Attractions
a [ [J[ "] San Diego Cuisine
[ Feod Ifthe topic _click here to

[1[] Beer drops here... move it.
M Famous SanThega

5. Click E' to save your work.
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ADD A TOPIC TO THE PRINT TOC

Adding a topic to the Print TOC follows basically the same steps. However, there are a few additional
steps because you must set printed output settings for the new topic.

1.
2.

3.

In the Project Organizer, expand the TOCs folder.
Double-click Print TOC. The TOC Editor opens to the right.

In the Content Explorer, select FamousSanDiegans.htm and drag it to the Print TOC. You will see
a blue arrow when you can drop it. Drop the topic under San Diego Cuisine and before
References.

TOC Editor T View: Tree

o Mote 1: You can quickly open a linked tq
Mote 2 You can build the TOC by dragg

TitlePage

Copyright

PrintTOC

All About 5an Diego

San Diego Attractions

San Diego Cuisine

Famous 5an Diegans |

CSomoooDooD

References |

In the TOC Editor, double-click Famous San Diegans. The Properties dialog opens.

@ Note: If double-clicking a TOC entry opens the topic instead of the Properties dialog, click

in the local toolbar of the TOC Editor to toggle the double-click behavior.

Select the Printed Output tab.

Famous San Diegans should be a new chapter in our PDF guide, so we will set it up to use these set-
tings.

In the Break Type field, select Chapter Break.

CHAPTER 5 | Getting Started Tutorial 7 7



7. Inthe Page Layout field, select Chapters. This is a page layout that is included with the San Diego

template.

8. Inthe Page Type field, select First Right. This will automatically start the chapter on a right page.

General Chapter Page Layout Break
Printed Output Break Type:
Avto-numbers | Chapter Break W |

Page Layout:
Conditional Tet

| Chapters - jContent/Resources/Pagelayouts/ w | COpen File
Auto-generate

Page Type: | First Right W |
Advanced

Chapter File Name: (default) w

\ Auto-end on 'left’ page: Enabled v

Itis recommended that you instead inject empty pages via the target. See the Help for more
information.

9. Click OK. When you build the PDF output, you will notice these settings.

10. Click IEI to save your work.

Note: There's more to preparing a project for print-based output than what we're showing you
here. How much is involved depends on how intricate you want to get with your output. See the

online Help for more information.
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ASSIGN A TOC TO A TARGET

The Print TOC file is already associated with our PDF target. But we still need to assign the Online TOC

file to our HTMLS5 target.

1. Inthe Project Organizer, expand the Targets folder.

Double-click the All About San Diego HTML5 target. The Target Editor opens to the right.

2
3. Select the General tab.
4

In the Master TOC field, select Online TOC.

Target Editor | % Build [ View - [ Publish |, Open Build Log
o7

General Output Type: Bl HTMLS
Skin

Comment: MNew Target
Conditional Tet )

Startup Topic: JContent/Home, htm
Variables

Master TOC: Online TOC
Publishing

Master Stylesheet: (default)
i~

5. Click IEI to save your work.

MORE INFORMATION

For more information about TOCs, see the online Help.
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CHAPTER 6

Building Output

After your targets are prepared, you are ready to build your final output. In this tutorial, you
will build PDF and HTML output.

%l Note: A PDF target has been created for you as part of the San Diego template.
However, if you want to build HTML5 output, you must first follow the tutorial steps

to create an HTMLS5 target. See "Creating a New Target" on page 56.

This chapter discusses the following:

Building HTML5 Output ..o 82
Building PDF OUtpUt - 85

OO



Building HTMLS Output

When you have finished adding all of your content to the project and made sure all of the styles and target
settings are set, you are ready to build your final output.

BUILD HTMLS OUTPUT

1.
2.

3.

32

In the Project Organizer, expand the Targets folder.

Double-click the All About San Diego HTMLS5 target.

'—a .
In the local toolbar of the Target Editor, click . The Builds window pane opens at the bottom
of the Flare interface, and the target begins to build.

Note: The Builds window pane opens automatically when you generate a target. You can monitor
the progress of the target's build status in this pane. As the target is building, you will see a light
green progress bar in the Build Progress column. When the build completes successfully, the pro-
gress bar turns dark green. If an error prevents the build from finishing, the bar turns red and the
build stops.

v 1 x

put Open Build Log | Stop Build Rebuild Target Build Targets

Target Project s Build Pro pile Progress Compile Status  Warnings Ignored Warnings Errors
1 |3/9/2016 3:21:30 BM | All About San Diego HTMLS [U ie topic: F|0 |0
o | 3/9/2016 3:21:12 PM | All About San Diego PDF__| U\ ieg| Finishe one [o [2

For more in-depth information about the information in the Builds window pane, please see the

online Help.

Note: There are several other ways to build a target, including from the Builds window pane and
from the Project ribbon.



VIEW HTML5 OUTPUT
After you have built your output, you can view it. In the Builds window pane, you can double-click the row.

Alternatively, in local toolbar of the Target Editor, you can click . The HTMLS5 output opens in your
default web browser.

ALL ABOUT

SAN DNEGO

Al AR SaN Cega Han DEygo Adlaclars AN Lhega LCusi F it han Liexga o

CALIFORMIA

All About San Diego

The Place to Find Information about America's Finest City

Welcome

Ean Diego is 2 beawiful place o ive, work. and wsi. This guide wil Inrodice pou 0 Amernica’s Finesi City
Iy i guigke, 'vou will isam about

San Deego history

Tip: You can set Flare to open output automatically when the build is finished. To do this, select
File>Options. In the Options dialog, select the Build tab, then select the check box next to View
output after successful build.

Note: If you build output while using a trial version of Flare, you will see jumbled characters in

your output. After you become a licensed user, you will be able to build output normally.
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REVIEW THE SAN DIEGO PROJECT IN HTML5 OUTPUT

We have made many changes to the San Diego project. Here is a list of things you might want to look at in
the HTMLS5 output. When you build your PDF output (see "Building PDF Output” on the following page),
compare the two and see how these items differ.

»

»

»

»

»

»

»

Home Page Look at the startup topic. Also notice how it has a different look and feel from the rest of
the topics. That's because it is using a different stylesheet and master page.

Cross-References Look for cross-reference links in the San Diego Cuisine topic.

Condition Tags Look at how condition tags affect drop-down text, or any other areas where you
may have added condition tags.

Drop-Down Text Look for drop-down text and its behavior.

Skins Look at the top of the topics and see the logo that you added.

Styles Experiment with the popup thumbnail style on the images in the San Diego Attractions topic.

Table of Contents Notice the way the navigation works in HTML5 output and how it differs from the
Table of Contents in PDF output. In HTMLS Top Navigation output such as this, the TOC is con-
verted to menus; you can also add context-sensitive side menus (use one of the Top Navigation pro-
ject templates when creating a project to see this in action). In Tripane outputs, the navigation will
look more like a traditional TOC in an online Help system.

MORE INFORMATION

For more information about building output and HTMLS5 targets, see the online Help.
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Building PDF Output

Now let's build the PDF output.

BUILD PDF OUTPUT

1. Inthe Project Organizer, expand the Targets folder.

2. Double-click the All About San Diego PDF target.

3. Inthelocal toolbar of the Target Editor, click @ Build] The Builds window pane opens at the bottom

of the Flare interface, and the target begins to build.

VIEW PDF OUTPUT

After you have built your output, you can view it. In the Builds window pane, you can double-click the row.

Alternatively, in local toolbar of the Target Editor, you can click . PDF output opens in your default

PDF viewer.

Bookmarks o

== +;_"+

‘ST ST SV 15D g Bl

b e s g g R .
ARl il S - ] M T ot . R M
[ Hestoey

. 8 L AL, K R B,
SAN D\EGO e e o e, aemaeg gy
S

[ cemate S

[ san Diego Attractions CALIFORNIA B

2 [ AN About 5an Diego

2 [ san Diego Cuisine
=[] Food
[ Mexican Food
[ seatocd
H Focd Trucks
S [ Besr

[ Alasmith Brewing
Comgany
[ Esiast Poirt Brawirg
& Sperits
[ stone Brewing
Comgany
[ References

. 3
i e
THIZ B I3 CPRATRC MG MATAS FLAAL

MLt K

ALL ABOUT R B ST B g s e T bt Y
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REVIEW THE SAN DIEGO PROJECT IN PDF OUTPUT

Here is a list of things you might want to look at in the PDF output. When you build your HTML5 output (see
"Building HTML5 Output" on page 82), compare the two and see how these items differ.

»

»

»

»

»

»

Condition Tags Look at how condition tags affect drop-down text (if you did not condition out drop-
downs), headings, or any other areas where you may have added condition tags.

Cross-References Look for context-sensitive cross-references in the San Diego Cuisine topic.

Drop-Down Text If you did not condition out the drop-down text in the San Diego Attractions topic,
look at how it appears when left in printed output.

Styles Look at the images in the San Diego Attractions topic (where you applied the thumbnail
popup style) and notice that the thumbnail setting was ignored because it doesn't apply to print-
based output.

Table of Contents Look at the Table of Contents and see how it differs from the navigation in
HTML5 output. Also notice how the chapters start on right pages, leaving a blank page on the pre-
vious left page. This includes the Famous San Diegans topic, which you set to be the start of a new
chapter.

Variables Look at the Copyright page and the variables on this page.

MORE INFORMATION

For more information about PDF targets, see the online Help.
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APPENDIX

PDFs

The following PDFs are available for download from the online Help.

TUTORIALS
Getting Started Tutorial
Product Foldout Tutorial
Top Navigation Tutorial

Tripane and PDF Tutorial

USER GUIDES
Accessibility Guide
Analyzer Guide
Autonumbers Guide
Condition Tags Guide
Context-sensitive Help Guide
DotNet Help Guide
Eclipse Help Guide

Getting Started Guide

Global Project Linking Guide
HTML Help Guide

HTMLS5 Guide

Images Guide

Importing Guide

Index Guide

Key Features Guide

Language Support Guide
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Movies Guide

Navigation Links Guide
Print-based Output Guide
Project Creation Guide
Pulse Guide

QR Codes Guide
Reports Guide

Reviews & Contributions Guide
Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide: Perforce

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet

Styles Cheat Sheet

Source Control Guide: Subversion
Source Control Guide: Team Foundation Server
Source Control Guide: Visual SourceSafe
Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker Guide
Variables Guide

WebHelp Outputs Guide

What's New Guide
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